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lesson   one
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skills
c Starting Word

c Exploring the Word
Screen

c Creating a Document
and Entering Text

c Saving and Closing a
Document

c Opening an Existing
Document

c Deleting and
Inserting Text

c Formatting Text

c Previewing and
Printing a Document

Introduction to Word
Microsoft Word 2002 is the latest edition of Microsoft’s powerful word processing
software application. It is designed to make the creation of professional-quality docu-
ments fast and easy. Word processing software allows you to type the text of a docu-
ment electronically and edit, move, and stylize that text, even after it has been written.
Word processors provide enormous flexibility in how the finished product will appear.

Word’s capabilities are not limited to text. As features have been added through the
various generations of the program, it has gained the capacity to serve as a desktop
publishing tool. Among many other features, Word will let you:

i Copy, move, and change the appearance of text within a document

i Share text and other page elements among documents

i Create documents using ready-made templates

i Add page numbers and footnotes to documents automatically

i Find and correct spelling and grammar errors automatically

i Insert tables, charts, and pictures in your documents

i Request help while you are using the program

i Search for specific instances of text and formatting within a document

i See how your document will appear on paper before printing it

While you work on a document, it is stored in your computer’s temporary memory. In
order to keep a document permanently so you can work with it again, Word enables
you to save it as a file on a storage device such as a floppy disk or hard disk drive.
You can use Word to create everything from a one-page business letter to a book con-
taining thousands of pages.

Lesson Goal:

Create a cover letter that will accompany a resume a student is sending in order to
apply for a job. 
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skill Starting Word

The first step in using the Microsoft Word program, or application, is launching it. The
Windows operating system provides a number of ways to launch programs. When you install
Word (or Microsoft Office, the suite of programs of which Word is a part), a shortcut to the
program is placed on the Windows Start menu automatically. You can also open Word by
locating and running its executable file, named Winword.exe, through My Computer or
Windows Explorer.

concept

Use the Start menu to launch the Microsoft Word application.

1. Turn on your computer and monitor and make sure that any peripheral devices such as
your mouse are connected properly. When your edition of the Windows operating system
finishes loading, the Windows desktop should appear on your screen (you may be asked to
provide a user name and password before Windows finishes loading).

2. Click the Start button            on the Windows taskbar at the bottom of your screen. The
Windows Start menu will appear.

3. Move the mouse pointer     up the Start menu to the Programs folder. The Programs menu
will open beside the Start menu.

4. Move the mouse pointer over to the Programs menu from the Start menu, and rest it over
Microsoft Word. The program name will be highlighted, as shown in Figure 1-1.

Newer editions of the Windows operating system such as Windows Me use person-
alized menus, which means that only the items you use most frequently are displayed on a
menu when it first opens. If Personalized menus are active on your computer and you do
not see Microsoft Word listed on the Programs menu, click the double arrow at the bottom
of the menu to display the rest of the program listings.

5. Click the left mouse button once. Word will open with a blank document in the window
(see Figure 1-2).            If your copy of Word has been used previously, the appearance of
the application window may differ from the one shown in the figure.

do it !

more
location or appearance of items such as the taskbar and the desktop are also subject to change. Furthermore, you can customize
the way in which you interact with the operating system. For example, you can alter the functionality of the mouse so that tasks
that normally require a double-click only require a single click. For the purposes of this book, the term click means to press
and release the left mouse button quickly. When instructed to double-click, you should press and release the left mouse button
twice in rapid succession. A right-click instruction requires you to press and release the right mouse button once. Finally, click
and drag means to press and hold the left mouse button down, move the mouse as instructed, and then release the mouse button
to complete the action.

Do not be alarmed if your desktop or Start menu do not match the descriptions above or the figures on the
next page exactly. With several different versions of Windows and countless software applications avail-
able, variances in system configuration are more than likely. Windows itself is highly customizable, so the
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Figure 1-1 Opening Word from the Start menu

Figure 1-2 Word application window

Windows desktop

Click the File menu title on the Menu bar. The File menu will drop down below its menu title. Move
the mouse pointer down the File menu and click the Exit command to close the Word application. If
you do not see the Exit command, click the double arrow at the bottom of the menu to expand the
menu. When you have successfully exited Word, use the Start menu to open the application again.

Practice

Blank document 
in the document
window
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skill Exploring the Word Screen

The Word application window consists of many features that are common to all applications
running under the Windows operating system. These include a Title bar, a Menu bar, docu-
ment and window control buttons, and toolbars. In addition to these items, Word has many
unique features that are designed to make document production fast, flexible, and convenient.
The main components of the Word window are shown in Figure 1-3 and are described below.

Figure 1-3 displays Word in a maximized window set to Print Layout View with the
Task Pane open. If your screen does not look like the figure, you can click View on the Menu
bar to access commands that will allow you to switch to Print Layout View and activate the
Task Pane.

The Title bar shows the name of the active document and the name of the application. New
documents are named Document1, Document2, etc., until they are saved with a new name.

The Menu bar displays the titles of the menus containing Word commands. Clicking one of
these titles will make its menu appear, listing the commands from which you can choose.
Word 2002 uses personalized menus by default, so only a few commands may appear when
you first open a menu. These are the commands that have been deemed most popular by the
designers of the software. If you do not click one of the available commands, the menu will
expand after a few seconds to reveal more commands. You can expedite this expansion by
clicking the double arrow at the bottom of the menu or by clicking the menu title again.
Alternatively, double-click the menu title to open the full menu right away. As you use Word
more and more, the program learns which commands you use most often. These commands
will then be the first to appear when you open a menu.

The Standard toolbar contains buttons that serve as shortcuts to commonly used commands.
When you rest the mouse pointer over a button, a ScreenTip that describes the button’s func-
tion appears. The Formatting toolbar contains the Font and Font Size boxes along with many
other options for formatting text and inserted objects. Overall, Word provides numerous other
toolbars to help you complete your tasks. Some of these toolbars will appear automatically
when you execute certain commands. You can activate any toolbar manually by opening the
View menu, highlighting the Toolbars command, and then clicking the name of the toolbar
you want to display on the Toolbars submenu. You hide an active toolbar by clicking its name
again on the submenu. You may also click and drag toolbars to change their order, or click
and drag them to other locations in the window.

In Print Layout View, the document window includes both a horizontal ruler and a vertical
ruler. The rulers enable you to keep track of your position on the page and view and change
the locations of items such as page margins, indents, tabs, columns, and table gridlines.

The insertion point is the blinking vertical bar that marks the place where text will appear
when it is entered, or where an object will be placed when it is inserted.

The document window is the open space in which your document appears. When the mouse
pointer is within the borders of the document it changes from the standard pointing arrow to
an I-beam so you can position it in text more accurately.

The Task Pane, which occupies the right side of the application window in the default setup,
is a new feature. It helps you organize your most important Word tasks in a single location.
The content of the Task Pane changes depending on the actions you are performing. For
example, there are different Task Panes for searching, formatting, and opening documents.

concept
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As shown in the figure above, the Standard and Formatting toolbars are arranged in a single row by
default. This setting gives you more screen space for your document, but limits the number of buttons
you can see on each of the toolbars. The double arrow pointing to the right at the end of the toolbar
indicates that more buttons are available. The downward-pointing arrow indicates that a menu will
appear if you click the arrows. Click a set of arrows and then click Show Buttons on Two Rows. The
Formatting toolbar will move below the Standard toolbar so you have a better view of both toolbars.

Practice

Figure 1-3 Components of the Word application window

In the current view, a vertical scroll bar appears on the right side of the document window, and a horizontal scroll bar is
found at the bottom of the window. The position of the scroll bar boxes within the scroll bars indicates where the visible
text is located in relation to the portions of the document that are not currently visible on the screen. Clicking the scroll
arrows at the ends of the scroll bars advances the document in small increments. Clicking in the scroll bar itself, above
or below the scroll bar box, advances the document in larger increments. You can also click and drag the scroll box
within the scroll bar to move substantial distances in a document (such as several pages at once).

The Status bar at the bottom of the application window provides feedback about your current activity in Word. The left
most section tells you what page and section of your document is currently displayed in the document window. It also
indicates the total number of pages in the document. The next section shows the distance the insertion point is from the
top of the page and its position on the page in terms of Line and Column number. The third portion of the Status bar is
reserved for showing whether certain Word modes such as Overtype and Track Changes are active.
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skill Creating a Document 
and Entering Text

Data that you enter in Word becomes part of an electronic file also known as a document. You
must have a document open in order to begin word processing. When you open the Word
application, a new blank document appears in the document window automatically. In Print
Layout View, the document is designed to look like an actual piece of paper. 

concept
Type a name and address in a new Word document to begin a letter.

1. Assuming you have already opened Word, a new document should be in the document
window with Document1 in the Title bar. You can also create a new document when Word
is running by clicking the New Blank Document button       on the Standard toolbar.

2. Use the keyboard to type the following text, pressing [Enter] after each line as indicated:

Sabrina Lee [Enter]
12 Oakleigh Ave. [Enter]
Indianapolis, IN 46202 [Enter]

3. The text will appear at the insertion point as you are typing it. When you are finished,
your document should look like Figure 1-4.

4. Leave the document open for use in the next Skill.

do it !

more
next line when you run out of space on the current line. When a word is too long to fit on the current line, it is placed at the
beginning of the line below, allowing you to type without interruptions or guesswork.

You may have noticed that some words have wavy red lines or purple dots beneath them. The wavy red lines indicate that
Word’s Automatic Spell Checking feature is active, and the underlined words are not recognized by Word’s dictionary. You will
learn how to spell check later in this book. Purple dots below a word or phrase indicate a Smart Tag. In this example, Word has
recognized “12 Oakleigh Ave.” as an address. If you place the I-beam mouse pointer over the purple underline, a Smart Tag
button       will appear. When you click the Smart Tag button, a menu containing commands related specifically to working
with addresses will appear. Smart Tags will appear in a variety of circumstances, including when you type names, dates, Web
addresses, and e-mail addresses. In each case, you can access a context-sensitive menu by clicking the smart tag button, giving
you control over operations in Word that usually involve using another program such as an address book or e-mail client.

In addition to launching Word or clicking a toolbar button, you can create a new document by clicking Blank Document in the
New section of the New Document Task Pane (see Figure 1-5). From the Task Pane, you can also create new documents from
existing ones and new documents from templates. For now, you will learn to use general blank documents. Other types of doc-
uments and methods of document creation will be covered in later lessons. Some commands have shortcut key combinations
associated with them. Pressing these key combinations on the keyboard is the same as executing the command from a toolbar
or from the Task Pane. For example, the keyboard shortcut [Ctrl]+[N] creates a new document.             If your Task Pane is
hidden, clicking the New command on the File menu will open the New Document Task Pane.

In this exercise, you pressed [Enter] after each line of text to begin a new one because an address consists
of short, distinct lines. When typing a document that does not require abbreviated lines, you do not have
to press [Enter] to begin a new line. Word uses a feature known as Word Wrap to continue the text on the
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Figure 1-5 New Document Task Pane

Click the New Blank Document button       on the Standard toolbar. A new document will open in its
own Word window. Type your name and address in the new document as if you were writing a letter.
When you are done, click the Document Close button       on the right end of the Menu bar to remove
this practice document from the screen. When Word asks if you would like to save the document,
click the button labeled No.

Practice
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Figure 1-4 Entering Text in Word
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skill Saving and Closing 
a Document

It is essential to save documents by giving them unique names and locations on a storage
device such as a floppy disk or hard disk. Otherwise, your work will be lost when you exit
Word. It is also a good idea to save documents periodically as you work on them to minimize
the amount of data lost due to power or computer failures. Closing a document removes it
from the screen and “files it away” so you can retrieve it and continue working with it later.
You can close individual documents and still leave Word running so you can work on other
documents.

concept

Save the name and address you typed in the previous Skill as a file and then close the file.

1. You should still have the name and address you typed in the previous Skill on your screen.
Click File, then click Save As to open the Save As dialog box.            When you are sav-
ing a document for the first time, the Save As dialog box will appear regardless of whether
you have chosen the Save command or the Save As command. The Save As dialog box
allows you to provide a file with a particular file name and select the location where the
file will be saved. Once a file has been saved, the Save and Save As commands have dif-
ferent functions. Using the Save command or the Save button       on the Standard toolbar
will overwrite the old version of the file with the current version, without opening a dialog
box. Using the Save As command will open the Save As dialog box, allowing you to save
another version of the file with either a new file name, a new storage location, or both.

2. When the Save As dialog box opens, Word provides a suggested file name based on the
initial text you have typed in the document. This default name is highlighted in the File
name box, so you can replace it simply by typing a new name. Type Address.doc to
replace the default file name.            .doc is the file extension for Word documents. A file
extension identifies a file as a certain type and associates the file with a specific program.

3. Word’s default storage location is your computer’s My Documents folder, which you can
see selected near the top of the dialog box in the Save in drop-down list box. You can
select a different location by clicking the Save in box to open its drop-down list, or by
clicking one of the buttons on the Places bar on the left side of the dialog box. (For exam-
ple, if you are to save your files on a floppy disk instead of the hard drive, insert the disk,
open the Save in drop-down list, and click 31⁄2 Floppy (A:) before continuing.) You also
can create new folders for your documents. Click the Create New Folder button       to the
right of the Save in box. The New Folder dialog box appears, as shown in Figure 1-6.

4. Type Word Files in the Name text box as the name of the new folder, and then click the
OK button                . The folder is created and selected immediately in the Save in box.
The dialog box should now look like Figure 1-7.            The folder you just created is a
subfolder of the My Documents folder, since that folder was selected in the Save in box
when you clicked the Create New Folder button.

5. Click the Save button                  in the bottom-right corner of the dialog box to save the
Address.doc file in the Word Files folder. The dialog box will close and the document
remains on the screen. Notice that the file name you provided in the Save As dialog box
now appears in the Title bar.

6. Click the Close button      on the right end of the Menu bar to close the active document,
Address.doc, but leave the Word application running.

do it !
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Figure 1-6 New Folder dialog box

Open a new document and type a short paragraph about how learning Word will be helpful to you.
When you are finished writing, save the document in your Word Files folder using the file name
Saving and Closing.doc. Then close the document but leave Word open.

Practice

more
You have probably noticed that there are two similar-looking Close buttons in the upper-right corner of the Word window. The
lower Close button       (as it appears with the mouse pointer resting over it), which sits by itself on the right end of the Menu
bar, is used for closing the active document. The upper Close button      , located on the Title bar, closes the application itself.
If you have documents with unsaved changes open when you click the application Close button, you will be prompted to save
the changes. Next to the application Close button are two buttons that help you control the size of the application window.
Clicking the Minimize button       hides the window from view, leaving only its program button on the taskbar. The middle but-
ton changes depending on the current size of the window. When the window is maximized, you will see the Restore button
which reduces the window to its last smaller size. When the window is reduced, you will see the Maximize button      , which
increases the size of the window so that it fills the screen. You can also access window control commands by clicking the Word
Control menu icon      on the left end of the Title bar.

If you modify a document and do not save the changes before you close it, Word will open a dialog box
that asks you if you want to save the changes. If you do not save, any changes you have made since the
last time you saved the document will be lost when the document closes.

Type name for
new folder here

Figure 1-7 Save As dialog box
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skill Opening an Existing
Document

To view or edit a document that has been saved and closed previously, you must open the
document from the location in which it was stored. Since Word documents are associated with
the Word application by the .doc file extension in their file names, you can double-click a
Word document in My Computer or Windows Explorer and Word will launch automatically.
However, if you are already working in Word, you can open Word files from directly within
the application. If the Student Files that accompany this book have been distributed to you on
a floppy disk, make sure you have inserted the disk in your floppy drive for this Skill.

concept

Open an existing Word document that was previously saved on a floppy disk or hard disk.

1. With the Word application running, click the Open button       on the Standard toolbar. The
Open dialog box will appear. The Open dialog is constructed very similarly to the Save As
dialog box you saw in the previous Skill.            You also can access the Open dialog box
by clicking File on the Menu bar and then clicking the Open command on the File menu.

2. Click the Look in drop-down list box. A list of locations available on your computer will
appear, as shown in Figure 1-8.

3. If your Student Files are stored on a floppy disk, click 31⁄2 Floppy (A:) on the drop-down
list to select your floppy disk drive. If your Student Files are stored on a local or network
drive, ask your instructor for the name of the location you should select.

4. If your Student Files are stored in a folder on your floppy disk or hard disk, you will need
to double-click that folder to display its contents in the dialog box’s Contents window.
Otherwise, you should already see a list of files in the Contents window. Click the file
named wddoit1-5.doc to select it.            It is possible that your computer is set to hide
file extensions of known file types, in which case you will see a file named wddoit1-5.

5. Click the Open button                   in the bottom-right corner of the dialog box. The Word
file wddoit1-5 will appear in the document window.

6. Click       on the right end of the Menu bar to close the document.

do it !

more
Files (*.*) setting. If you only want to view Word documents, select the Word Documents (*.doc) setting.

If you click the arrow on the right edge of the Open button in the Open dialog box, menu appears that offers commands for
opening a document in a specific manner. If you select Open Read-Only, Word will not allow allow any permanent changes to
be made to the document during that particular work session unless you use Save As to save the document as a new file.
Otherwise, you can edit the text on your screen and print, but you will not be able to save the changes. The Open as Copy com-
mand creates a new copy of your document, allowing you to keep the old version and edit the new one. The Open in Browser
command becomes active when you have selected an HTML document in the Contents window. Executing this command
enables you to view the document with your default Web browser instead of Word. Finally, use the Open and Repair command
to open and recover a document that has been damaged by a program, system, or power failure.

Files that you have worked with recently appear at the bottom of the File menu and on the Task Pane so you can open
them without having to go through the Open dialog box (see Figure 1-9).

Word can open a variety of file types in addition to the standard Word document (.doc). Which files
appear in the Open dialog box depends on the setting in the Files of type box. To ensure that you are 
seeing all the files that are stored in the selected directory, click the Files of type box and select the All
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Figure 1-9 Opening recent documents

Names of recent
files appear as
commands;
click file name
to open file

To practice opening a document, open the Student File named wdprac1-5.doc. Type a few sentences
explaining the steps you used to open the file. Then use the Save As command to save the file in your
Word Files folder using the name mywdprac1-5.doc (if you have been instructed to use only floppy
disks, create a new Word Files folder on a floppy disk). Close the file and leave Word running when
you are done.

Practice
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Figure 1-8 Open dialog box
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skill Deleting and 
Inserting Text

One of the fundamental advantages of word processing is the ease with which it enables you
to change content that has been entered previously. Word makes it easy to edit, replace, or
delete unwanted or inaccurate text. Editing skills are crucial for updating older documents and
making revisions that will turn your rough drafts into final drafts.

concept
Modify text in an existing document.

1. Open the Student File wddoit1-6.doc.            In the Open dialog box, you can open a file
by double-clicking it instead of clicking it once and then clicking the Open button.

2. Move the I-beam mouse pointer to the immediate right of the abbreviation Ave. in the sec-
ond line of the address at the top of the document. Click to place the insertion point at the
end of the line.

3. Press [Backspace] on the keyboard once to erase the period.

4. Type nue to complete the word Avenue.

5. Click between the two and the three in the date January 23, 2002 to place the insertion
point between the two numbers.

6. Press the [Delete] key on the keyboard to erase the number three.

7. Type the number 4 on the keyboard to complete the date change. The document should
now look like the one shown in Figure 1-10.

8. Save the file in your Word Files folder using the file name Deleting and Inserting.doc.

9. Close the file.

If you make a mistake while working in Word, you can reverse your last action by 
clicking the Undo button         on the Standard toolbar. Click the arrow next to the Undo but
ton to open a menu that lists all of your previous actions, allowing you to undo multiple 
actions at once (see Figure 1-11).

do it !

more
by text to the right instead of typing over it. To type over existing text so that it disappears instead of moving, double-click the
Overtype button          on the Status bar to enter Overtype mode. Just remember that any text to the right of the insertion point
will be deleted as you type. Double-click the Overtype button again to deactivate Overtype mode.

You can move the insertion point one character at a time to the left or right and one line at a time up or down with the arrow
keys on the keyboard. This is especially helpful when you are moving the insertion point only a short distance. Additional ways
to move the the insertion point using the keyboard are shown in Table 1-1. If you will be using the [Home], [End], [Pg Up],
and [Pg Dn] keys on the numeric keypad, as required for some of the movement techniques described in the table, make sure
that Num Lock is disabled. Many keyboards now include separate keys for these functions.

As you just saw, the [Backspace] key (some keyboards spell it Back Space and some only use a left-point-
ing arrow) erases the character immediately to the left of the insertion point. The [Delete] key erases the
character to the right of the insertion point. Word inserts text at the insertion point; that is, it moves near-



I N T E R A C T I V E C O M P U T I N G Word 2002 WD 1.13

Figure 1-11 Undoing multiple actions

To practice inserting and deleting text, open the Student File wdprac1-6.doc and follow the instruc-
tions given in the file. When you are finished, save the file in your Word Files folder as mywdprac1-
6.doc and close the file.

Practice
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Figure 1-10 Document after editing

Edited text

Most recent action

Table 1-1 Moving the insertion point with the keyboard

To Move the Insertion Point Press

Left or right one word [Ctrl]+[      ] or [Ctrl]+[      ]

Up or down one paragraph [Ctrl]+[      ] or [Ctrl]+[      ]

Up or down one screen [Pg Up] or [Pg Dn]

To the beginning or end of a line [Home] or [End]

To the beginning or end of a document [Ctrl]+[Home] or [Ctrl]+[End]
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skill Formatting Text

Word enables you to change the font (typeface), font size, text style, and text alignment easily
in a document, as well as many other text and document characteristics. Formatting text
serves to improve the presentation of your document. You can format text for both stylistic
and organizational purposes.

concept
Apply bold formatting to text in a letter and change the font size of the document.

1. Open the Student File wddoit1-7.doc.

2. Select Assistant to the Director of Public Relations in the first paragraph of the letter by
clicking before the A and dragging (moving the mouse with the left mouse button held
down) to the end of Relations (release the mouse button). Do not select the period. The
selected text will be white on a black background.

3. Click the Bold button       on the Formatting toolbar. The letters in the job title will be set
in a heavier text style.

4. Deselect the text by clicking once anywhere in the document window.

5. Select the entire document by clicking before the S in Sabrina at the top of the letter and
dragging down to the last line (release the mouse button after the period in enc.).
You also can select an entire document by pressing the keyboard shortcut [Ctrl]+[A].

6. Click the Font Size arrow          on the Formatting toolbar. A list of font sizes will appear.
Click 10, as shown in Figure 1-12. The document text decreases in size.

7. Click the Font arrow                         , and then click the font named Arial on the drop-
down list (you may have to scroll up the list of fonts). The typeface of the document
changes to the Arial font.

8. Deselect the text as you did above and scroll to the top of the document.

9. Save the document in your Word Files folder as Formatting Text.doc and close it.

do it !

more
newspaper is generally 10-point type. Other Formatting toolbar options include Italic , Underline , Font Color , and
Highlight . The Font Color and Highlight buttons are always loaded with a color, which is indicated as part of the button
icon. Clicking the buttons applies the formatting with the loaded color. Clicking the arrow next to the buttons opens a color
palette, enabling you to select a different color. Another formatting option, Alignment, refers to the manner in which text fol-
lows the margins of your document (see Figure 1-13). Like the Italic, Underline, and Bold buttons, the Alignment buttons are
toggle buttons, meaning you can apply and remove their formatting by clicking the same button.

Knowing how to format text for maximum effect is an essential skill that will make your documents appear crisp and profes-
sional. Notice how formatting is used on this page: different fonts and font sizes are used for headings and subject matter and
important terms are colored for added emphasis. As you saw above, you must select items before you can format them. Note
that you also can select an entire document by opening the Edit menu and clicking the Select All command. You can align an
entire paragraph simply by placing the insertion point inside the paragraph before clicking the desired alignment button.

The Formatting toolbar allows you to change numerous text attributes. Font, or typeface, refers to the
actual shape of each individual character as it appears on the screen or in a printed document. Font size is
usually measured in points, with 72 points being equivalent to one inch. As an example, the text in a
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To practice formatting text, open the Student File wdprac1-7.doc and follow the instructions given 
in the file. When you have completed the exercise, save the file in your Word Files folder as 
mywdprac1-7.doc. Then close the file.

Practice
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Figure 1-12 Changing font size

You also may click in
the Font Size box, type
a font size, and press
[Enter] to apply it

Figure 1-13 Text alignment

Aligned left:
text is flush
with the left
margin and
ragged on
the right

Aligned right:
text is flush
with the right
margin and
ragged on 
the left

Text alignment
buttons

Centered: text
is placed evenly
between the
two margins

Justified: words
are spaced
evenly so text is
flush with both
margins
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skill Previewing and 
Printing a Document

While today’s classrooms and offices are relying more and more on electronic documents,
many people still prefer to work with hard copies (paper printouts) out of their documents. If
your computer is properly connected to a printer, you can print a paper copy of a document
with a click of a button. Or, if you desire more flexibility in printing, Word provides compre-
hensive printing options, including a Print Preview that allows you to see the document as it
will appear when printed.

concept

Preview and print a document.

1. Open the Student File wddoit1-8.doc.

2. Click the Print Preview button       on the Standard toolbar. The open document will
appear in Preview mode. The reduced size of the document allows you to view how your
text is arranged on the page.

3. Move the mouse pointer over the upper-left corner of the document. The pointer should
appear as the Magnifier tool, as shown in Figure 1-14. If the Magnifier tool is not present,
click the Magnifier button       on the Print Preview toolbar.

4. Click the upper-left corner of the document with the Magnifier tool. The preview will
zoom in to 100% so you can see the document at its normal size. Notice that the
Magnifier tool now contains a minus symbol instead of a plus symbol. Click again to
zoom back out.

5. Click the Close button         on the Print Preview toolbar to return to the regular document
window.

6. Click File on the Menu bar, then click the Print command. The Print dialog box appears,
as shown in Figure 1-15.

7. Click the OK button                 to print the document with the default print settings.
Clicking the Print button       on the Standard toolbar skips the dialog box and

prints using the default print settings automatically.

8. Close the document. You do not need to save it.

do it !

more
list, click the current value in the Zoom box, type a new percentage, and press [Enter] on the keyboard.

To edit a document while in Print Preview mode, click the Magnifier button       to toggle it off. The mouse pointer will change
to an I-beam. You then can enter and edit text as you normally would.

While Print Layout View affords you many of the same advantages as Print Preview mode, Print Preview includes some very
useful and unique features. For example, you can choose to view multiple pages of a document on the same screen by clicking
the Multiple Pages button       on the Print Preview toolbar. You also can reduce by one the number of pages in a document by
clicking the Shrink to Fit button       so that a small portion of text is not left alone on one page. Word accomplishes this reduc-
tion by decreasing the font sizes used in the document.

For more precise control over your view in Print Preview mode, click the Zoom box arrow                to
open a list of magnification percentages. Then click a percentage on the drop-down list. The percentages
are based on 100% being the actual size of the document. To select a Zoom percentage that is not on the
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Figure 1-15 Print dialog box

To practice previewing and printing a document, open the Student File wdprac1-8.doc. Preview and
print the file as instructed in the document. When you have completed the exercise, close the file. You
do not have to save the file.
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Figure 1-14 Print Preview mode

Magnifier tool Click to obtain
context-sensitive
pointer that
allows you to get
help on features
by clicking them

Click to select a
different printer

Click to increase
number of
copies printed

Click to specify
a range of
pages to print

Click to select
odd or even
pages only

Print Preview
toolbar
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shortcuts
Function Button/Mouse Menu Keyboard

Create new document Click File, then click New [Ctrl]+[N]

Close active document Click File, then click Close [Ctrl]+[W]

Save document Click File, then click Save or Save As [Ctrl]+[S]
for the first time

Save changes to Click File, then click Save [Ctrl]+[S]
existing document

Save document with new Click File, then click Save As [Alt]+[F], [A]
name and/or location

Open existing document Click File, then click Open [Ctrl]+[O]

Undo most recent action Click Edit, then click Undo [Ctrl]+[Z]

Bold text Click Format, then click Font; [Ctrl]+[B]
choose Bold, then click OK

Italicize text Click Format, then click Font; [Ctrl]+[I]
choose Italic, then click OK

Underline text Click Format, then click Font; [Ctrl]+[U]
choose Underline, then click OK

Align text left Click Format, then click Paragraph [Ctrl]+[L]

Align text right Click Format, then click Paragraph [Ctrl]+[R]

Center text Click Format, then click Paragraph [Ctrl]+[E]

Justify text Click Format, then click Paragraph [Ctrl]+[J]

Select All Click Edit, then click Select All [Ctrl]+[A]

Print active document (skips dialog box) Click File, then click Print [Ctrl]+[P]

Exit Word Click File, then click Exit [Alt]+[F4]
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quiz
A. Identify Key Features

Name the items indicated by callouts in Figure 1-16.

B. Select the Best Answer

10. The exact location where text appears when entered a. Alignment

11. The shape of characters such as letters and numbers b. Print Preview

12. Reduces a window to a button on the Windows taskbar c. Task Pane

13. The way in which text relates to the page’s margins d. Insertion point

14. A window that contains options for executing a command e. Dialog box

15. Allows you to see how your document will appear when printed f. Points

16. The unit of measurement for font size g. Minimize button

17. New feature that organizes numerous important features in one location h. Font

Figure 1-16 Elements of the Word screen

1.
2.
3.

4.

5.

7.

6.

8.

9.
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quiz (continued)

18. In order to apply bold formatting to a section of existing
text, you must first:

a. Click one of the Formatting buttons

b. Save the document

c. Select the text to be formatted

d. Click the Start button

19. Clicking the       button:

a. Ejects the floppy disk

b. Saves the active document

c. Searches your hard drive for a file

d. Selects the active line or paragraph

20. Clicking the       button on the Standard toolbar:

a. Searches the document for spelling errors

b. Magnifies the document

c. Opens Print Preview mode

d. Opens the Task Pane

21. The file extension for Word documents is:

a. .txt

b. .htm

c. .doc

d. .mp3

22. Examples of text formatting do not include:

a. Font size

b. Justification

c. Text style

d. File extensions

23. The icon that appears when Word recognizes text you
have entered and can provide related commands is a:

a. Shortcut

b. ScreenTip

c. SmartTag

d. Task Pane

24. Text that is justified is:

a. Grammatically correct

b. Adjusted to meet both margins

c. Bold

d. Only visible in Print Preview

25. A button that turns a feature both on and off is called a:

a. Drop-down list

b. SmartTag

c. Toggle button

d. Scroll bar box

26. The Status bar provides all of the following information
except:

a. Number of misspelled words in the document

b. Status of Overtype mode

c. Number of pages in the document

d. Position of the insertion point in the document

C. Complete the Statement

WD 1.20
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interactivity

WD 1.21

1.  Identify a job that interests you and determine what the employer is looking for in a prospective employee:

a. Go to the classified section of a newspaper or to a Web site that lists jobs and find a specific job listing that you think
might suit you (Web sites you may try: www.careerbuilder.com, www.monster.com, www.jobs.com).

b. Think about what skills and experience might be necessary to apply for the job you have found. Determine how your
own skills and experience relate to the qualifications that the job would require.

2.  Open Word and write a brief letter applying for the job (open the file wdskills1.doc to view a sample letter if you need
some guidance in composing and organizing your letter):

a. Launch Word using the Start menu.

b. Enter your name and address at the top of the page.

c. Skip a line and enter today’s date.

d. Skip a line and enter the name (if available) and address of the prospective employer.

e. Write your letter, beginning with the salutation and continuing with three or four short paragraphs, one each for your
educational background, prior job experience, any other relative experience, and the reasons for your interest in this
particular position.

3.  Format the text of the letter:

a. Change the font size of the text to 11 pt and the font to Garamond.

b. Format your name at the top of the letter with Bold type and highlight the position you are applying for in yellow.

c. Align your name and address with the right margin.

4.  Print, save, and close the letter, and then exit Word:

a. Use Print Preview to examine your letter and make any content or formatting changes you think are necessary.

b. Close Print Preview and print one copy of your letter.

c. Save the letter in your Word Files folder as Job Seek.doc.

d. Close the document.

5.  Open, edit, and save an existing document:

a. Open Job Seek.doc from your Word Files folder.

b. Italicize your name and align your name and address with the left margin.

c. Save the changed document as a new file in your Word Files folder named Job Seek2.doc.

d. Close the document and exit Word by clicking the application Close button on the right end of the Title bar.

Build Your Skills
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1.  Open a new document in Word and type your name, address, and today’s date on consecutive lines. Then, skip a line
and type a few sentences about an extracurricular activity or hobby that you enjoy. Format the document so that it matches
the example shown in Figure 1-17. Finally, save the document in your Word Files folder as wdsolved1.doc and print it.

2.  As the Assistant Technical Director at VER Recovery Corp., a collection agency, you have been asked to research vari-
ous word processing programs to determine which is the best for your company’s needs. After testing several products and
considering prices, you have decided that the company would benefit most from adopting Microsoft Word 2002. Use a
new blank Word document to write a memo to your boss that details this decision. Be sure to include your name as part of
the document. When you are done, save the file in your Word Files folder as VER Recovery memo.doc.

3.  Due to the quality of your work as Assistant Technical Director at VER, you have been promoted to Associate Technical
Director. As your first act in your new capacity, you have proposed an expansion of the Information Technology depart-
ment. Your proposal has been approved. Using Word, write a notice for the company bulletin board to announce the good
news. Include a text in the document that calls for employees who are interested in transferring into the department to con-
tact you (include your name). Take advantage of Word’s formatting features such as bolding, underlining, font sizing, and
text alignment to make your document lively. Save the document in your Word Files folder as VER IT notice.doc.

4.  Your favorite entertainment-oriented Web site is looking for regular viewers who are interested in contributing movie
reviews to the site on a weekly or monthly basis. If you are chosen based on your sample review, you will have your opin-
ions published on the site on a regular basis and receive coupons for the site’s online store. Use Word to write a review of
the last movie you watched, either in a theater or at home. Use formatting techniques to call attention to the parts of your
review that you feel are the most important, and therefore deserve emphasis. Save the document in your Word Files folder
using the name Review by [Your Name].doc.
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interactivity (continued)
Problem Solving Exercises

Figure 1-17 Problem solving exercise


